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Installation and Activation

Install DocView
This section explains the basic steps for installing DocView.

Hardware Requirements

• OS Required: Windows NT

• Memory: 128 MB RAM minimum

• Hard Disk Capacity: 10 GB minimum

Installation Steps

To install DocView application on your machine follow the steps mentioned below: -

1. Insert the installation CD ROM in the diskette

2. Double click on the setup.exe
Installation program starts

3. Follow the on-screen instruction to complete the installation

Activate DocView

Activation (Auto)

When application launches it will check for the activation file.

CLIENT 

PRODUCT NOT ACTIVATED

• Display a message to the user 

• Display the activation form (This form will contain the required information to be filled
by the user). The Serial Key is compulsory 

• Connect to the Activation Server 

CONNECTED

? Send the request for activation

SERVER

• Validate the request

• Check for the Serial Key

VALIDATION SUCCESS

? Generate UNLOCK file

? Send the UNLOCK file as response to user

VALIDATION FAIL

? Send False response

CLIENT 

• Decrypt the UNLOCK file

• Display ACTIVATION COMPLETE message

Sample User Manual. Created By: Aslam Khan. Author: Aslam K



Activation (Manual)

This is a case when the user is not having a facility for internet connection from the machine where
DocView is installed. The user can either email to the Administrator or make a call using telephone for
activation. The administrator registers the call and sends the activation files via email.

CLIENT

• Register the information with the administrator

ADMINISTRATOR

• Note the details of the CLIENT

• Enter the CLIENT information and serial  key in the server database

• Generate the activation file

• Mail the file to the CLIENT

CLIENT

• Receive the file 

• Start activation program using DocView application

• Specify the activation file location

• Application activates the product
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Overview
DXDocView is a desktop based cost effective document storage and retrieval solution.

DXDocView addresses your requirements to search/retrieve simple indexed documents. You can scan
documents or import external scans into the system and index them.

DocView allows you to index documents using upto 15 user specific index fields. Indexing facilitates
easy document retrieval at a later stage. You can create new index or modify existing one as and when
required.

DocView enables you to categorize documents to be indexed. These categories are available in a
predefined list that can be customized.

Additional features like print, e-mail, compile documents, recent documents list, favorites list, reading
list etc., are also incorporated in DocView making it an ideal application of its own kind.

Basic navigation, view and zoom features of DocView make online viewing of documents an easy and
exciting experience.
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Starting DocView
DocView can be started like any other application. After you have started your workstation, you can
click 'DocView' option in Programs menu to launch the application.

Login

The first thing you will see on starting the application.

Fig 1.0 Login Dialogue Box

User Name Type your system User Name here

Password Type your password here. You will not be able to see the characters you enter as
you type them, so someone else cannot find out your password. As the system
keeps close track of all the actions of every user, it is important for you to keep it a
secret.

Login Clicking this will send your User Name and Password to the central server for license
and user validity checks.

Cancel Clicking this will cause the Login Screen to disappear and will stop the login process.
The application will stop completely. To start again you will have to click on the
desktop icon.

You must login with a valid Username and Password and click “OK”. Once your Username and
Password have been validated by the system, you will see the DocView interface.
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Working with Documents

Import Document
DocView allows you to import scanned documents into the DocView system.

To import a document click 'Import Document' icon on the toolbar or select 'Import' option from the
'File' menu. Doing this opens the 'Import Document' dialog box.

On the 'Import Document' dialog box double-click on the 'Import Document' icon. You will see the
'Import Document' interface.

'Import Document' interface allows you to import documents  in any of the available categories. 

While importing the documents you have to enter the Index data for the documents that is stored in
the search database and is required for searching and retrieving the documents later.

Fig 4.0 Import Document dialog box

Scan Selecting this will open the DocView Scan dialog

Import Selecting this will open the Import Document interface

Note:

Make sure you have configured the import location before importing the files. (To see how to
configure the import location refer section  9.1 System Configuration)
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Import Document Screen

The 'Import Document' screen is divided into two windows  i.e. Left and Right window.

Left window of the Import Document screen has commands that allow you to browse and load the
documents on the interface, select category and enter Index data. It also displays the list of loaded
documents.

Right window of the Import Document screen displays the selected document and Import toolbar that
allow you to navigate through the documents, Zoom In/Out and Import the selected documents.

Fig 6.0 Import Document Screen

Left Window Commands

Browse Clicking this will display the Browse for Folder dialog box

Show All/Selected Clicking this will show all files available in the list. This is a toggle and
clicking again on the same button will display the files that are
currently selected

Categorize Clicking this will open the Select Category dialog box. Here you can
choose the required category

Index Clicking this will display the Index Fields. Here you can enter the Index
data for the documents to be imported

Import Options Toolbar buttons

First Page Clicking this will take you to the first page

Previous Page Clicking this will take you to the previous page

Next Page Clicking this will take you to the next page

Last Page Clicking this will take you to the last page

Fit to Page Clicking this allows you to view the entire page on the interface

Fit to Width Clicking this will reduce the page size so that you don't have to scroll
horizontally view entire text line

Zoom In Clicking this will allow you to view the document in enlarged size

Zoom Out Clicking this will allow you to view the document in reduced size

Import Clicking this will Import the selected document

Close Import Window Clicking this will close the Import document screen
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Scan Document
DocView has an integrated scanning module that enables documents scanning. Later you can Import
the scanned document using the import option (Refer to 'Import' section for details) of DocView.

DocView supports TWAIN image acquisition standard, allowing you to add and use a wide variety of
scanner models.

To scan a document click the 'Scan Document' icon on the toolbar or select 'Scan' option from the 'File'
menu. The 'DocView Scan Interface' appears on the screen as a new window.

'DocView Scan Interface' allows you to select source and the required output file format.

Fig 3.0 DocView Scan Dialog Box

Select File Format It is a drop down list of different image file formats from which you can
choose the required format for the output scans

Select Source Allows you to select the source scan drivers. Clicking this will display
the available source scan drivers for you to select the required one.

Acquire Clicking this will send a scan start signal to the TWAIN interface
driver

Cancel Clicking this will cause the DocView Scan interface to disappear. To
start scanning again you will have to click the Scan Document icon on
the toolbar.

Note:

Make sure you have configured the scan location before scanning the documents. (To see how to
configure the scan location refer section  9.1 System Configuration)
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Open Document
You can open any of the documents stored in the system for viewing on the application interface.

To open a document click the 'Open Document' icon on the toolbar or select 'Open' option from the
'File' menu. On doing this you will see the 'Open Document' dialog box.

The Open Document dialog box displays the list of available categories in the left pane.

On selecting the required category, document titles of all the documents pertaining to that category is
displayed in the right pane of the interface along with the total number of pages, date and time. A
maximum of 20 documents can be displayed in a view.

You can select the document to be loaded from the list displayed on the 'Open Document'dialog box.

Fig 2.0 Open Document Dialog box

>> Clicking this will display next 20 document titles, if the list has more than 20 entries

<< Clicking this will display previous 20 document titles,  if the list has more than 20
entries

Open Clicking this opens the document selected from the list of documents displayed in
the right pane of the 'Open Document' dialog box

Cancel Clicking this will close the 'Open Document' dialog box
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Export Document
You can export the open document to any other storage location.

To export a document click the 'Export Document' icon on the toolbar or select 'Export' option from the
'File' menu. On doing this you will see the 'Export Document' dialog box.

'Export Document' dialog box allows you to specify the Export Location where you want to transfer the
exported pages. It also allows you to choose the page range for the document pages to be exported.

Fig 3.0 Export Document dialog box

Export Location Allows you to browse and select the required export location.

Page Range options: - 

All Exports all the pages of the document

Current Exports the page currently displayed on the interface

Page Range Exports the range of pages specified by you

Export Clicking this will export the selected pages of the document as per 
the Page Range options set by you

Cancel Clicking this will close the Export Document dialog box

Note: You can specify page numbers and/or page ranges separated by commas. For example 1-5, 10,
14-20.
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View Document/Page properties
You can view the document and page properties of the document or page you are viewing.

To see the document/page properties select 'Properties' option from 'File' menu and then choose
'Document/Page ' as required. This will display the 'Document/Page Properties' dialog box.

Document Properties

Fig 4.0 Document Properties dialog box

Document Name Displays name of the document

Created Date/Time Displays Date and Time of creation

Total Files Displays total number of files in the document

Document Size Displays total size of the document

Index Field Displays list of the Index Fields

Index Values Displays values of the Index Fields

OK Clicking this will close the Document Properties dialog box

Page Properties

Fig 5.0 Page Properties dialog box

Document Name Displays name of the document to which the page belongs

Created Date/Time Displays Date and Time of creation

Filename Displays the filename

File Size Displays filesize

File Type Displays the filetype

Bit Depth Displays the value of Bit Depth

Resolution Displays value of the resolution

OK Clicking this will close the Page properties dialog box

Sample User Manual. Created By: Aslam Khan. Author: Aslam K



Email
DocView allows you to Email scanned documents to your desired destination as an attachment.

To Email a document click 'Email' document icon on the toolbar or select 'Email' option from 'File' menu.
On doing this you will see the 'Email' document dialog box.

The Email document dialog box allows you to specify recipients email id, write the message and select
the page range.

You can send email to multiple recipients at one go, by specifying their Email Id's separated by semi
colon.

Fig 6.0 DocView Email Dialog Box

Send To Type the recipient's Email Id here

Mail Text Type your message here (optional)

Page Range options: - 

All Emails all the pages of the document

Current Emails the page currently displayed on the interface

Page Range Emails the range of pages specified by you

Send Clicking this will email the selected pages of the document as per 
the Page Range options set by you

Cancel Clicking this will close the DocView Email Document dialog box
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Print Document
You can open and print any of the documents in the DocView system.

To print a document click the 'Print Document' icon on the toolbar or select 'Print' option from the 'File'
menu. On doing this you will see the 'Print Document' dialog box.

'Print Document' dialog box allows you to select any of the printer. You can specify the Print Range  of
pages to be printed.

Fig 3.0 Export Document dialog box

Printer options

Printer Allows you to select any of the available printer

Print Range options: - 

All Prints all the pages of the document

Pages Prints the range of pages specified by you

OK Clicking this will print the pages as per the page range options set by
you

Cancel Clicking this will close the Print dialog box
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Lists

Favorites List

Add To Favorite

DocView allows you to add your favorite pages from different documents to the favorites list , so that
it is easy to open them in the future .

To add a page to the favorites list, go to the page you want to add and click 'Add To Favourites' icon
on the toolbar or select 'Add To Favourites' option from 'File' menu.

Doing this will add the page to the favorites list.

View Favorites List

You can view the favorites list at any time while you are working on DocView.

To view the favorites list, click 'View Favorites' icon on the toolbar or select 'View Favorites' option
from 'View' menu. Doing this will display the 'View Favorites' dialog box.

The 'View Favorites' dialog box lists the document titles and the page numbers of the pages that are
added to the Favorites list.

To open the documents you can select the document title and hit 'OK'.

Fig 6.0 View Favorites dialog box

OK Clicking this opens the document selected in the list

Cancel Clicking this closes the View Favorites dialog box

Note and Tips:

Selecting the Document Title on the 'View Favorites' dialog box opens the document with first page
as the default opening page.

Selecting the Page Number on the 'View Favorites' dialog box opens the document with the selected
page as the default opening page.

If the page you are adding is already present in the Favorites List, the application will display
message 'This document page already exists in favorite list'

Sample User Manual. Created By: Aslam Khan. Author: Aslam K



Reading List

Add Document to the Reading List

DocView allows you to add documents of your preference to the reading list.

To add a document to the reading list, open the document you want to add and click 'Add to Reading
List' icon on the toolbar or select 'Add Document to Reading List' option from 'File' menu.

Doing this will add the document to the Reading list.

View Reading List

You can view the documents in the Reading List any time when you have DocView open.

To view the Reading List, click 'View Reading List' icon on the toolbar or select 'View Reading List'
option from 'View' menu. Doing this will display the 'View Reading List' dialog box.

The 'View Reading List' dialog box lists the document titles of the documents added to the Reading
list. The date and time when the documents were added to the list is also displayed.

To open the documents you can select the document title and hit 'OK'.

Fig 7.0 View Reading List dialog box

OK Clicking this opens the document selected in the list

Cancel Clicking this closes the View Reading List dialog box
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Search Documents
DocView gives you customized search options which searches the search terms entered by you  for
selected category, index fields depending on the search criteria (AND/OR/PHRASE).

DocView allows you to search within a selected category or across all defined categories.

To start search click 'Search' icon on the toolbar or select 'Search' option on the menu bar. Doing this
will display the search documents interface.

The Select Categories window of the search documents interface displays all the defined categories.
You can select the required category and view its Index Fields that are displayed in the Select Index
Fields window.

Fig 12 Search Documents Interface

Select Index Fields Index Fields of the category you have selected is displayed here

Select Category List of all the defined categories is displayed here

Search Terms Enter the terms you want to search here

Search Criteria It is a drop down menu that allows you to select the search criteria.
Search criteria available are PHRASE, AND, OR

Search Results It is a drop down menu that allows you to select the number of
results to be displayed on the screen at a time

From/To Date Allows you to select the date from/to for searching documents
created in a particular time frame

Go Clicking this sends a command to the search engine to start search

Clear Clicking this clears the details of the previous search

Previous Clicking this will display previous 20 search results, if the list has
more than 20 entries.

Next Clicking this will display next 20 search results, if the list has more
than 20 entries.

Note: Double click on the search results to open the document on DocView interface.
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Research

Compile
DocView allows you to create your own compiled documents.

You can add page(s) from different documents to the compiled documents. Compiled documents help
you to gather pages of importance and store them into single document for future reference.

You can delete page(s) from the compiled documents or delete existing compiled documents at any
point of time.

You can also Print and Email compiled documents.

Add Page

To add page to compiled documents select Research menu, point to compile and click 'Add Page
option'. Doing this will display the Add Page to Compiled Document dialog box.

Add Page to Compiled Document dialog box allows you to create compiled document, or add page(s)
to existing compiled document that are listed in the dialog box.

Fig 13 Add Page To Compiled Document dialog box

Create Clicking this displays the Add Page To Compiled Document dialog box. Here you
can define the name for the new compiled document you are creating.

Add Page Clicking this adds the page currently displayed on the interface to the compiled
document selected by you.

Cancel Clicking this will close the Add Page To Compiled Document dialog box

Previous Clicking this will display previous 20 compiled documents, if the list has more than 20
items.

Previous Clicking this will display next 20 compiled documents, if the list has more than 20
items.
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View Compiled Documents

To view the compiled documents select Research menu, point to compile and click 'View Compiled
Documents' option. Doing this will display the Compiled Document dialog box.

The 'View Compiled Documents' dialog box allows you to open or delete any of the compiled
documents listed on the dialog box.

Fig 14 View Compiled Documents Dialog Box

Open Clicking this opens the selected compiled document on the DocView interface

Cancel Clicking this will close the View Compiled Documents dialog box

Delete Clicking this will delete the selected compiled document. Before deleting the
document, message for confirming deletion is displayed

Note: Make sure you close the documents you are deleting before hitting the delete option.
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Threads
DocView enables you to link related pages using threads (smart links).

At times accessing a particular document is not enough. Accessing related documents may be
required as well.

DocView allows creation of thread which is a combination of related pages links for quick reference.

While accessing a document you can easily access the related pages using threads.

You can add any number of threads to a document. Unwanted page(s) or threads can be deleted at any
point of time.

Add Page

To add page to a thread select Research menu, point to threads and click 'Add Page' option. Doing this
will display the 'Add Thread Details' dialog box.

'Add Thread Details' dialog box allows you to add new thread and add currently displayed page to any
of the existing threads.

Fig 15 Add Thread Details dialog box

Add New Thread Clicking this allows you to create new threads. Dialog box for Thread
Title will be displayed where you can specify the name for the new
thread.

Add Page Clicking this adds the page currently displayed on the interface to
the thread selected by you.

Cancel Clicking this closes the Add Thread Details dialog box.
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Manage Threads

DocView allows you to manage threads as per your requirement.

You can delete unwanted thread(s) or delete page(s) from the existing threads.

To add page to a thread select Research menu, point to threads and click 'Manage Thread' option.
Doing this will display the 'Delete Thread' dialog box.

'Delete Thread' dialog box allows you to delete unwanted thread(s) or page(s) from threads.

Fig 16 Delete Thread dialog box

Delete Thread Clicking this deletes unwanted thread you have selected

Delete Page Clicking this deletes unwanted Page you have selected

Cancel Clicking this closes the Delete Thread dialog box.
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View Threads

While viewing a document you can view a list of threads attached to it.

To view threads attached to a document, select 'View Related Document' option under 'Lists' menu.
Doing this will display 'View Related List' dialog box.

'View Related List' dialog box displays the list of all the threads attached to the document you are
viewing. You can even open any of the page listed on the dialog box.

Fig 17 View Related Documents Dialog Box

Open Clicking this opens selected by you on the DocView interface

Cancel Clicking this closes the 'View Related Documents' dialog box
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Manage

Categories
DocView allows you to manage categories. You can add, delete or modify categories as per your
requirement.

DocView has an option to import predefined index while adding new categories.

To manage categories click the 'Manage' icon on the toolbar and choose 'Categories' option from the
drop down list or select 'Categories' option from 'Manage' menu. Doing this will display the 'Manage
Categories' dialog box.

Manage Categories dialog box allows you to add new category, modify existing categories, delete
categories and import predefined index.

Fig 8.0 Manage Categories dialog box

Add Clicking this will add a new category

Modify Clicking this allows you to modify an existing category

Save Clicking this will save new categories or modifications made to the existing
categories

Delete Clicking this will delete the category selected

Close Clicking this closes the manage categories dialog box

Import Index Clicking this allows you to import predefined Index

Note: You cannot delete or modify the default category.
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Index
DocView allows you to manage Index as per your requirements.

You can view and modify index of the documents as and when required.

To view and modify index click the 'Manage' icon on the toolbar and choose 'Index' option from the
drop down list or select 'Index' option from the 'Manage' menu. Doing this will display 'View/Modify
Index' dialog box.

The 'View/Modify Index' dialog box displays all Index Fields and their values.

'View/Modify Index' dialog box allows you to modify the index values. You can click on the index
values and make the required changes.

To save the changes use the save button on the dialog box.

Fig 17 View / Modify Index dialog box

Save Clicking this will save the modifications you have made to the Index Values

Cancel Clicking this will close the View/Modify Index dialog box
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Documents
DocView allows you to delete documents from any of the categories.

To delete a document click 'Delete Documents' icon on the toolbar or select 'Delete Documents' option
from the 'Manage' menu. Doing this will display the 'Delete Document' dialog box.

'Delete Document' dialog box displays all the categories and their documents they contain. 'Delete
Document' dialog box allows you to delete unwanted documents from the system.

Fig 9.0 Delete Documents dialog box

>> Clicking this will display next 20 document titles, if the list has more than 20 entries

<< Clicking this will display 20 document titles,  if the list has more than 20 entries

Delete Clicking this deleted the document selected from the list of documents displayed in
the right pane of the 'Delete Document' dialog box

Cancel Clicking this will close the 'Delete Document' dialog box
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System

Configuration
DocView allows you to define the scan /import destination location and document format using the
'Configuration' option.

To change the configuration of the application click the 'Configuration' icon on the toolbar or select
'Configuration' option under 'System' menu. Doing this will display the 'Configuration' dialog box.

'Configuration' dialog box allows you to browse and select the scan and import location as per your
preference. It also allows you to specify the document format required for the output scan files.

Fig 10 Configuration dialog box

Scan Location Type the scan location here or click the browse button to select the
scan location

Import Location Type the import location here or click the browse button to select the
import location

OK Clicking this will save the configuration settings and close the dialog
box

Cancel Clicking this will close configuration dialog box without saving the
settings

Note: Please create the Scan and Import directories before you configure the Scan and Import
Location.

Change Password
DocView has an option to change the system password in case required for security purpose.

To change the password click 'Change Password' icon on the toolbar or select 'Change Password'
option from 'System' menu. Doing this will display 'Change Password' dialog box.

Fig 11 Password dialog box

Old Password Type the current password here

New Password Type the new password here

Confirm Password Re-type the new password here for confirmation

OK Clicking this will save the changes you have made

Cancel Clicking this will close the 'Password' dialog box
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Backup
DocView allows you to take backup of the system data.

DocView provides you with two backup options that are Copy and Move.

Any of the two options allow you to select documents and specify the destination location for the
same.

Copy

Copy option allows you to take the backup and stores the source data.

To backup data using copy option select 'Copy' from 'File' menu. Doing this displays the 'Copy
Documents' dialog box.

Fig 18 Copy Documents dialog box.

Copy Clicking this will execute the copy operation. Source data will be stored in the same
location

Cancel Clicking this will close the 'Copy Documents' dialog box

Delete Item Clicking this delete the selected documented. You can use this option if you have
selected wrong document

<< Clicking this will display previous 20 document titles, if the list has more than 20
entries

>> Clicking this will display next 20 document titles, if the list has more than 20 entries
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Move

Move option allows you to take the backup and deletes the source data.

To backup data using move option select 'Move' option from 'File' menu. Doing this displays the
'Move Documents' dialog box.

Fig 18 Move Documents dialog box.

Move Clicking this will execute the move operation. Source data will be deleted

Cancel Clicking this will close the 'Move Documents' dialog box

Delete Item Clicking this delete the selected documented. You can use this option if you have
selected wrong document

<< Clicking this will display previous 20 document titles, if the list has more than 20
entries.

>> Clicking this will display next 20 document titles, if the list has more than 20 entries.
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User Features

Navigation

You can navigate page-by-page or to any page of the document using the navigation buttons on the
DocView toolbar.

Left pane of the DocView interface displays list of filenames present in the document.. You can click
on any filename in the list you wish to view.

Navigation buttons on the DocView toolbar

Clicking this will display the first page of the document

Clicking this will display the previous page

Clicking this will display will display the next page

Clicking this will display the last page of the document

Clicking this will displays the Go-To-Page dialog box. Enter the page you wish to view
and hit enter

Customized View

DocView gives customized view options like Single, Double and Full Screen.

Clicking on the appropriate view buttons on the DocView toolbar allows you to select the required
view options.

Clicking this will display one page on the interface at a time

Clicking this will display two pages on the interface at a time

Clicking this will display the document in Full screen mode

Zoom

DocView allows you to zoom in to the picture to pixel resolution.

You can select the zoom options by clicking on the zoom buttons available on the DocView toolbar.

Clicking this will display the page in enlarged size

Clicking this will display the page in reduced size

Clicking this will display zoom percentage drop down menu. Select the required zoom
settings

Clicking this will reduce the display so that the entire page fits in the document
window

Rotate

DocView allows you to rotate page by an angle of 90, 180 and 270 degrees as selected.

To rotate a page click on the rotate button on the DocView toolbar.

Clicking this will display the rotate drop down menu. Select the required angle to set
rotation.
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Appendix A: List of keyboard shortcuts
Shortcut Key Description

View Options

Ctrl + S Single Page View

Ctrl + D Double Page View

Ctrl + L Full Screen Mode

Esc Quit Full Screen Mode

Navigation Options

Home Move to First Page

End Move to Last Page

Page Down Move to Next Page

Page Up Move to Previous Page

Ctrl + N Go To Page

Up Arrow Vertical scroll upwards (Small Change)

Down Arrow Vertical scroll downwards (Small Change)

Left Arrow Horizontal scroll towards left (Small Change)

Right Arrow Horizontal scroll towards right (Small Change)

Ctrl + Shift + Up arrow Vertical scroll upwards (Large Change)

Ctrl + Shift + Down arrow Vertical scroll downwards (Large Change)

Ctrl + Shift + Left arrow Horizontal scroll towards left (Large Change)

Ctrl + Shift + Right arrow Horizontal scroll towards right (Large Change)

Zoom Options

Ctrl + + Zoom In

Ctrl + - Zoom Out

Ctrl + 0 Fit to Page

Ctrl + 1 Fit to Width

Ctrl + 2 Fit to Height

Ctrl+Shift+L Lock Zoom Settings

Rotate Options

Ctrl + up arrow Rotate Page by 0°

Ctrl + right arrow Rotate Page by 90°

Ctrl + down arrow Rotate Page by 180°

Ctrl + left arrow Rotate Page by 270°

General Options

F1 Doc View Help

Alt + V + W Show/Hide Pane

Alt + V + T Show/Hide Toolbar

Ctrl + Shift + V Lock Scroll Position

Alt + F4 Quit Application
Table 1.0 List of DocView shortcut keys
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